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Notices 

Manual Part Number 

CG00053 Rev C 

Legal Notices 

© 2017 10x Genomics, Inc.  All rights reserved.  Duplication and/or reproduction of all or any portion of this 
document without the express written consent of 10x Genomics, Inc., is strictly forbidden.  Nothing contained 
herein shall constitute any warranty, express or implied, as to the performance of any products described 
herein.  Any and all warranties applicable to any products are set forth in the applicable terms and 
conditions of sale accompanying the purchase of such product.  10x Genomics provides no warranty and 
hereby disclaims any and all warranties as to the use of any third party products or protocols described 
herein.  The use of products described herein is subject to certain restrictions as set forth in the applicable 
terms and conditions of sale accompanying the purchase of such product. “10x”, “10x Genomics”, “Changing 
the Definition of Sequencing”, “Chromium”, “GemCode”, “Loupe”, “Long Ranger”, “Cell Ranger” and 
“Supernova” are trademarks of 10x Genomics, Inc.  All other trademarks are the property of their respective 
owners.  All products and services described herein are intended FOR RESEARCH USE ONLY and NOT FOR 
USE IN DIAGNOSTIC PROCEDURES. 

Nothing in this document should be construed as altering, waiving or amending in any manner 10x 
Genomics, Inc., terms and conditions of sale for the Chromium™ Controller or the Chromium Single Cell 
Controller, consumables or software, including without limitation such terms and conditions relating to 
certain use restrictions, limited license, warranty and limitation of liability, and nothing in this document 
shall be deemed to be Documentation, as that term is set forth in such terms and conditions of sale. Nothing 
in this document shall be construed as any representation by 10x Genomics, Inc that it currently or will at 
any time in the future offer or in any way support any application set forth herein. 

 

Customer Information and Feedback 

For technical information or advice, please contact our Customer Technical Support Division online at any 
time.   

Email: support@10xgenomics.com 

10x Genomics 

7068 Koll Center Parkway 

Suite 401 

Pleasanton, CA 94566 USA  
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Introduction 

Single Cell Suspension for Optimal Performance 

10x Genomics® Single Cell Protocols require a suspension of viable single cells as input. Minimizing the 
presence of cellular aggregates, dead cells, non-cellular nucleic acids and potential inhibitors of reverse 
transcription is critical to obtaining high quality data. 

This Cell Preparation Guide describes best practices and general protocols for washing, counting and 
concentrating cells from both abundant and limited cell suspensions (greater than or less than 100000 total 
cells, respectively) in preparation for use in 10x Genomics Single Cell Protocols.  

The general protocols described here are expected to be compatible with many, but not all, cell and sample 
types. Additional optimization may be required for the preparation of cell types that are particularly 
sensitive to suspension composition or handling technique. Preparation of single cells from solid tissues or 
cryopreserved samples may also require additional dissociation and handling strategies not covered here. 
For additional information on preparation of specific sample types, consult 10x Genomics Demonstrated 
Protocols available on the 10x Support site: support.10xgenomics.com. 
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Recommended Reagents & Equipment 

Supplier Description 
Part Number 
(US) 

- Refrigerated Benchtop Centrifuge for 15 ml and 50 ml tubes - 

 Microcentrifuge for 2 ml LoBind tubes - 

 Inverted tissue culture microscope with 10X/20X magnification and 
fluorescence imaging capability 

- 

Rainin Tips LTS 1ML Filter RT-L1000FLR 17007954 

 Tips LTS W-O 1ML Fltr RT-L1000WFLR 17014297 

 Pipet-Lite LTS Pipette L-1000XLS+ 17014382 

VWR Sterile Polypropylene Centrifuge Tubes with Flat Caps, 50 ml 82018-050 
 Sterile Polypropylene Centrifuge Tubes with Flat Caps, 15 ml 21008-103 

 10 ml Serological Pipette 89130-898 

Integra PIPETBOY acu 2 155018 

Eppendorf DNA LoBind Tubes, 2.0 ml* 022431048 

Corning Cellgro Phosphate-Buffered Saline (PBS) 1X without calcium & magnesium 21-040-CV 

Sigma-Aldrich 
Phosphate-Buffered Saline (PBS) with 10% Bovine Albumin 
(alternative to Thermo Fisher product) 

SRE0036 

Thermo Fisher 
Scientific 

UltraPure™ Bovine Serum Albumin (BSA, 50 mg/ml) (alternative to 
Sigma-Aldrich product) 

AM2616 

 Trypan Blue Stain (0.4%) for use with the Countess® Automated Cell 
Counter 

T10282 

 Countess® II Automated Cell Counter† AMQAX1000 

 Countess® II Automated Cell Counting Chamber Slides† C10228 

 Live/DEAD Viability/Cytotoxicity Kit for mammalian cells L3224 

EMD Millipore Scepter™ 2.0 Handheld Automated Cell Counter† PHCC20060 

 Scepter™ Cell Counter Sensors, 60 µm† PHCC60050 

 Scepter™ Cell Counter Sensors, 40 µm† PHCC40050 

iNCYTO Hemocytometer C chip† DHC-N01 

Miltenyi Biotec MACS SmartStrainers, 30 µm 130-098-458 

Bel-Art Flowmi™ Cell Strainer, 40 µm H13680-0040 

ibidi µ-Slide VI - Flat 80621 

*No substitutions are allowed. Items have been validated by 10x Genomics® and are required for Single Cell 
workflow, training and system operations. †10x Genomics recommends the Countess II Cell Counter for most 
counting applications, but users should determine the best system for specific sample types.  
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1. Tips 

1.1. Best Practices for Handling Biological Samples 

Best practices for handling any sample type include following all applicable biohazard safety regulations, 
using sterile technique, nuclease-free reagents and consumables, minimizing pipetting steps, and using 
wide-bore pipette tips where possible to minimize cell damage. 

1.2. Concentration for Optimal Performance 

The total number of cells required in the suspension used as input to 10x Genomics® Single Cell Solutions is 
determined by the cell recovery target defined by the user. Refer to the applicable 10x Genomics Single Cell 
Protocol to determine this relationship. 

If possible, it is recommended to bring the input cell suspension to a concentration that allows pipetting 
between 2.5 and 15 µl into each reaction. Using suspension volumes less than 2.5 µl increases variance due 
to pipetting inaccuracy, while using volumes larger than 15 µl increases the risk of introducing unwanted 
debris or inhibitors into the reactions. For example, if the total number of input cells required is 1700, then 
the optimal cell concentration is in the range of ~200 to 700 cells/µl. 

The cell concentration should always be determined based on the total number of cells, not just viable cells. 
Moreover, some loss is inevitable from every washing and resuspension step due to cells adhering to tube 
walls and pipette tips. It is therefore critical to estimate the number of input cells from the final single cell 
suspension.   

1.3. Factors Influencing Cell Recovery 

To recover the expected number of cells, it is critical to maximize viability, minimize the cell preparation 
time, accurately measure the input cell concentration and pipette the correct volume into each reaction.  

Ideally, input cell suspensions should contain more than 90% viable cells. Non-viable and dying cells 
generally contain less and more fragmented RNA that may not be efficiently captured by 10x Genomics 
Single Cell Solutions. The presence of a high fraction of non-viable cells in the input suspension may 
therefore decrease the apparent efficiency of cell partitioning and recovery. 

Depending on cell type, viability may significantly decrease when cells are kept in suspension for a 
prolonged period of time before use. Some cells types, such as peripheral blood mononuclear cells (PBMCs), 
can form clumps when they are kept in PBS for an extended period of time. Such clumps are not easily 
dissociated into single cells by pipette mixing and can therefore decrease the effective concentration of 
single cells in the input suspension. Cell suspensions should therefore be loaded as soon as possible after 
preparation, ideally within 30 min. 

Clumps, debris and fibers can also interfere with accurate cell counting, especially when using an 
automated cell counter. Thus, minimization of cell clumps, debris and fibers by filtering or other techniques 
is necessary for accurate cell counting and loading (see Section 1.7). 
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1.4. Regular-Bore versus Wide-Bore Pipette Tips 

To minimize physical damage to cells from shearing forces, it is critical to pipette gently and slowly during 
cell resuspensions. Using roughly treated cells as input will compromise system performance. It is 
particularly important to pipette cell suspensions gently when using a regular-bore pipette tip as its smaller 
diameter is more likely to shear and damage cells. The speed at which the cell suspension is passing 
through the opening of the pipette tip is also an important factor – the faster it passes through, the more 
damaging the process. 

The use of wide-bore pipette tips is therefore recommended for most pipetting steps. However, generating 
single cell suspensions from pellets or clumps is best achieved using a regular-bore pipette tip. The 
protocols in this guide therefore call for regular-bore pipette tips when resuspending cells after the final 
wash step. 

1.5. Centrifugation Conditions 

Cell number, concentration, size and density all influence pelleting efficiency at a given centrifugation speed, 
time, and temperature. Thus, the optimal centrifugation conditions may need to be optimized for specific 
sample types. 

The ideal centrifugation conditions will generate a solid, but not too tightly packed, cell pellet with minimal 
cells remaining in the supernatant. Minimizing cells in the supernatant is especially important for 
maintaining an accurate representation of heterogeneous samples that contain cells of variable sizes. 
Excessive centrifugation may decrease viability. Moreover, a tightly packed cell pellet may require extra 
pipetting to resuspend the cells, which can also damage cells due to shearing effects. 

Recommended initial centrifugation conditions are 150 rcf for 3 min at room temperature for larger cells 
such as most immortalized cell lines and 300 rcf for 5 min at room temperature for smaller cells such as 
PBMCs. When working with a new sample type, save and count cells in the supernatants to ensure that 
losses are low. 

1.6. Washing & Resuspension 

The recommended cell washing and resuspension solution is 1X PBS (calcium and magnesium free) 
containing 0.04% weight/volume BSA (400 µg/ml). BSA is added to minimize cell losses and aggregation. 
Primary cells, stem cells, and other sensitive cell types may require washing and suspension in alternative 
buffers to maximize viability. If necessary, PBS can be replaced with most common cell culture buffers. 

The following alternative buffers have been verified to not influence performance of 10x Genomics® Single 
Cell Protocols when profiling mixtures of human 293T/17 and mouse NIH/3T3 cell lines:  

• Dulbecco’s Phosphate-Buffered Saline (DPBS) 

• Hank’s Balanced Salt Solution (HBSS)  

If cell viability cannot be maintained in one of these buffers, it is also possible to wash and resuspend in 
most common cell culture media, with or without serum. The following media have been verified to be 
compatible with 10x Genomics Single Cell Protocols with little or no loss of performance when profiling 
mixtures of human 293T/17 and mouse NIH/3T3 cell lines: 

• Eagle’s Minimum Essential Medium (EMEM) + 10% FBS 

• Dulbecco’s Modified Eagle Medium (DMEM) + 10% FBS 
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• Iscove’s Modified Eagle Medium (IMEM) + 10% FBS 

• Roswell Park Memorial Institute (RPMI) + 10% FBS 

• Ham’s F12 + 10% FBS 

• 1:1 DMEM/F12 +10% FBS 

• M199 

When washing and resuspending cells, always use sufficient volumes to maintain concentrations at less 
than 5000 cells/µl (e.g. less than 5 million cells per tube when using 1 ml washing solution in 2 ml LoBind 
tubes). Maintaining cells at higher concentrations can cause aggregation and clumping that will interfere 
with generation of ideal single cell suspensions.  

1.7. Straining 

GEM generation occurs in microfluidic channels that are narrower than the typical human hair (i.e. <100 µm). 
To ensure optimal system performance, care should be taken to avoid introduction of debris, fibers or 
clumped cells into these channels. Removing debris and clumps is also important for accurate cell counting 
with automated counters. 

Filtering cell suspensions with an appropriate cell strainer is helpful for removing large clumps and debris. 
The strainer should have a pore size that is larger than the maximum cell diameter in the sample, but small 
enough to catch larger clumps. 

Depending on the degree of clumping and the strainer type, the number of cells and the amount of wash 
solution retained in the strainer can vary. For general use, the MACS SmartFilter is recommended as it 
generally causes minimal changes to the cell concentration. However, a volume loss of 100 µl or more can 
occur. For low cell suspension volumes, the Flowmi™ Tip Strainer is recommended to minimize volume 
losses. However, the cell concentration can decrease by 30% or more. It is therefore important to measure 
the cell concentration after straining for an accurate cell count. 
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2. General Sample Preparation 

2.1. Overview 

This Protocol is intended as general and initial guidance on straining, washing and concentrating input cell 
suspensions for 10x Genomics® Single Cell Protocols when working with unfamiliar or uncharacterized 
cells. Solid tissues and other large cell aggregates must be dissociated using mechanical or enzymatic 
dissociation, cell sorting, or other cell isolation techniques before proceeding with this Protocol. Further 
optimization – such as adjusting the number of wash steps, the composition of the wash solution, 
centrifugation conditions, and type of strainer – may be required to remove ambient RNA and contaminants 
while maximizing the purity and recovery for a specific cell type (refer to Section 4 for advice on how to 
assess the concentration and quality of a cell suspension). 

The Protocol is best suited for abundant samples for which avoiding cell losses during washing and 
straining is not critical. If the initial cell suspension is estimated to contain less than 100000 cells in total, 
refer to Section 3 for recommendations on the preparation of limited samples. 

2.2. General Cell Preparation Protocol 

This Protocol assumes that cells are already in a largely single cell suspension from cell 
culture, dissociated tissues, cell sorting, or other cell isolation methods. 

a) Obtain a vial containing cells of interest in suspension. 

b) Using a wide-bore pipette tip, gently and thoroughly mix the cells. Determine the cell 
concentration using a Countess® II Automated Cell Counter or other counting device 
(see Section 4 for more information on cell counting). 

Quantification at this point enables an approximation of the appropriate volume for the 
subsequent resuspension in order to obtain target concentrations. When determining the 
volume for resuspension, assume ~25% of cells will be lost during wash steps. 

c) If significant amounts of cell clumps or debris are observed, gently mix cells by 
pipetting up and down 10 – 15 times and filter cells using a cell strainer with an 
appropriate pore size. 

d) Centrifuge cells at 300 rcf for 5 min. 

In general, recommended initial centrifugation conditions are 300 rcf for 5 min at room 
temperature for smaller cells such as many primary cells, and 150 rcf for 3 min at room 
temperature for larger cells such as many immortalized cell lines.  

Larger cells need to be centrifuged at lower speed or for shorter time to preserve the cell 
integrity. Some very small cells may need to be centrifuged at even higher speeds (e.g. up 
to 400 rcf) or for longer time (e.g. up to 10 or 15 min) to minimize cell loss due to inefficient 
pelleting. However, excessive centrifugation speed can compromise the cell integrity and 
viability. 

Depending on the rotor type, the cell pellet forms on the side or on the bottom of the conical 
vial. Know the expected position of the pellet, especially when working with small or limited 
cells, as the pellet can be difficult to see. 

NOTE 

NOTE 

CRITICAL! 

NOTE 
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e) Remove supernatant without disrupting the cell pellet. Save the removed supernatant 
in another tube until the Protocol is complete. 

f) Using a wide-bore pipette tip, add 1 ml 1X PBS with 0.04% BSA to the tube. Gently 
pipette mix 5 times and invert tubes to resuspend the cell pellet. 

g) Centrifuge cells at 300 rcf for 5 min. 

h) Remove supernatant without disrupting the cell pellet. Save the removed supernatant 
in another tube until the Protocol is complete. 

i) Add the appropriate volume of 1X PBS with 0.04% BSA to achieve the target cell 
concentration. Gently pipette mix 10 – 15 times or until the cells are completely 
suspended. 

Do not invert the tube in this step as cells can stick to the sides of the tube, thereby 
changing the cell concentration. 

j) Use a cell strainer to remove any remaining cell debris and large clumps. For low cell 
suspension volumes, a Flowmi™ Tip Strainer is recommended for minimal loss of 
additional sample volume. 

k) Determine the cell concentration using a Countess® II Automated Cell Counter or other 
cell counting device.  

If cell concentration is much lower than expected, check the concentration of saved 
supernatants and re-pellet the supernatant at a higher centrifugation speed. It is possible 
that cells were not efficiently pelleted at the initial speed or were lost to the cell strainer. 

l) If necessary, adjust the volume to obtain the target cell concentration. 

m) Once the target cell concentration is obtained, place the cells on ice. 

n) Proceed with the 10x Genomics® Single Cell Protocol. 

 
 

NOTE 

NOTE 
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3. Preparation of Limited Samples 

3.1. Overview 

This Protocol outlines how to process cells when cell number is <100000 in order to maximize the recovery 
yield while minimizing the cell damage. It is important to handle cells as little as possible and save all the 
supernatants until the Protocol is complete. Washing the cells once is recommended, but it may be possible 
to skip washing completely if the number of available cells is very small and there is little visible debris in 
the suspension. If cells are unstable in PBS, the buffer can be replaced with most common cell culture 
buffers and media with minimal reduction in performance (Refer to Section 1.6 for more information). 

3.2. Limited Sample Preparation Protocol 

This Protocol assumes that cells are single cells suspended from tissue dissociation, cell 
isolation, or FACS-sorted into PBS, other buffers, or media. 

a) Using a wide-bore pipette tip, gently and thoroughly mix the cells. Determine the cell 
concentration using a Countess® II Automated Cell Counter or other cell counting device 
(see Section 4 for more information on cell counting). 

Quantification at this point enables an approximation of the appropriate volume for the 
subsequent resuspension in order to obtain target concentrations. When determining the 
volume for resuspension, assume ~25% of cells will be lost during wash steps. 

b) If cell clumps or cell debris are observed, gently mix cells by pipetting up and down 10 
– 15 times and filter cells using a cell strainer with an appropriate pore size. 

c) Centrifuge cells at 300 rcf for 5 min. 

Some cells need to be centrifuged at higher speed (e.g. up to 400 rcf) or for longer time (e.g. 
up to 10 or 15 min) to minimize cell loss due to inefficient pelleting.  However, be careful 
not to over-centrifuge as increased centrifugation speed can compromise the cell integrity 
and viability. 

Depending on the rotor type, the cell pellet forms on the side or on the bottom of the conical 
vial. Know the expected position of the pellet, especially when working with small or limited 
cells, as the pellet can be difficult to see. 

d) Remove the supernatant without disrupting the cell pellet, leaving ~50 μl or an 
appropriate volume of supernatant to achieve the target cell concentration. Save the 
removed supernatant in another tube until the Protocol is complete. 

e) Using a regular-bore pipette tip, resuspend the cell pellet in the leftover supernatant 
by gently pipetting up and down 10 – 15 times. 

If losing more cells can be tolerated, it is recommended to wash cells at least once before 
counting to remove any ambient RNA and contaminants. For washing, add 1 ml PBS with 
0.04% BSA, mix gently, and repeat steps c – e.  

f) Determine the cell concentration using a Countess® II Automated Cell Counter or other 
cell counting device.  

NOTE 

NOTE 

NOTE 

NOTE 

CRITICAL! 



PREPARATION OF LIMITED SAMPLES 

__________________________________________________________________________________________________ 
 

10x Genomics® Single Cell Protocols – Cell Preparation Guide • Rev C 10 Click to TOC 

If cell concentration is much lower than expected, check the concentration of saved 
supernatants and re-pellet the supernatant at a higher centrifugation speed. It is possible 
that cells were not efficiently pelleted at the initial speed.  

g) If necessary, adjust the volume to obtain the target cell concentration. 

h) Once the target cell concentration is obtained, place the cells on ice. 

i) Proceed with the 10x Genomics® Single Cell Protocol. 
 

NOTE 
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4. Cell Counting & Quality Control 

4.1. Overview 

Visualization of cell suspensions is critical for accurate determination of cell concentration and viability, 
suspension quality and cell sizes prior to use in 10x Genomics® Single Cell Solutions. 

To determine accurate cell counts, best practices include sampling the cell suspension at least twice and at 
least two counts on each sample (i.e. a minimum of four counts in total, based on two independent draws 
from the cell suspension).  

The Countess® II Automated Cell Counter is recommended for determining cell concentrations for most 
applications. Sample types with very small cells, highly variable cell sizes or high levels of aggregation may 
require alternative counting methods. 

When characterizing a sample type for the first time, it is recommended to perform two different counting 
and viability assays. The first method is to stain cells with trypan blue and count the cell concentration and 
viability using the Countess® II (Section 4.2). The second method is to stain cells with fluorescent dyes and 
measure cell viability using a tissue culture microscope and automated cell counting software (Section 4.4). 
The latter method is particularly useful for accurate characterization of very small and heterogeneous cell 
populations such as PBMCs. If a tissue culture microscope and imaging solution is not available, manual 
counting using a hemocytometer can also be a useful control. 

Cell suspensions should also be checked visually for debris or cell aggregates as these can clog microfluidic 
channels. If observed, additional pipetting or filtering may be required to obtain optimal performance. 
Pipetting should be done gently and carefully to avoid lysing or otherwise damaging cells. In general, 
filtering or straining does not decrease cell viability. 

Visual estimation of cell size (diameter when in suspension) can also be useful for setting expectations about 
relative cDNA yields and transcript counts from different sample types. The number of distinct cDNA 
molecules captured from a cell is correlated to its RNA content. In general, the RNA content of a cell 
correlates with its size. Thus, larger cells are expected to yield more cDNA than smaller cells. For example, 
1200 NIH/3T3 cells (average cell diameter = ~16 µm) contain significantly more total RNA (~16 pg/cell) than 
1200 PBMCs (mean diameter = ~8 µm, ~1 pg/cell), which means that the former are expected to yield 
significantly more cDNA and higher complexity libraries. 
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4.2. Using a Countess® II Automated Cell Counter 

Refer to the manufacturer’s user guide for details and advice on the operation of the 
Countess® II Automated Cell Counter. The optimal range of cell concentration for this device 
is 100 to 4000 cells/μl. 

a) Thoroughly vortex 0.4% trypan blue stain and centrifuge briefly. 

b) Using a wide-bore pipette tip, gently and thoroughly mix the cells.  

It is critical that the cell suspension is homogeneous to minimize sampling error. Also 
ensure that cells are free of debris and fibers as these can interfere with cell counting. 

c) Immediately, aliquot 10 μl cells and mix with 10 μl 0.4% trypan blue stain. Gently 
pipette mix. 

d) Transfer 10 μl trypan blue stained cells to a chamber on Countess® II Cell Counting 
Slide. 

e) Insert the slide into the Countess® II Cell Counter, and determine the cell concentration 
and cell viability. 

Optimization of focusing and light exposure are critical for accurate counting. 

 

4.3. Using Other Automated & Manual Cell Counters 

The following table summarizes the advantages and disadvantages of the Countess® II 
and two alternative methods: the EMD Millipore Scepter™ Handheld Automated Cell 
Counter and manual hemocytometers. 
 

Instrument Advantages Disadvantages Cost 
Cell Size 

Range 

Countess® II 
Fast 

Automated 
Cannot measure viability 

of very small cells 
$$ 7 – 60 µm 

Scepter™ 
Fast 

Automated 

Limited dynamic range 

Needs multiple sensors 
for different cell sizes 
Cannot visualize cells 

$$ 
3 – 18 µm 
8 – 25 µm 

Hemocytometer Flexible Slow, manual $ Any 

 
  

NOTE 

NOTE 

NOTE 
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4.4. Using Fluorescent Viability Stains & Microscopy 

The Thermo Fisher Scientific LIVE/DEAD® Viability/Cytotoxic kit for mammalian cells is 
recommended for measuring viability of mammalian cells. Refer to the manufacturer’s 
user guide for detailed instructions and advice. Other kits or dyes may require fluoresence 
filters with alternative excitation and emission ranges. 

Prepare fresh staining solution immdiately before use. 

a) Thaw Calcein AM (4 mM) and Ethidium homodimer-1 (EthD-1, 2 mM) tubes to room 
temperature. 

b) Vortex both tubes and briefly centrifuge. 

c) Add 2 μl EthD-1 to 100 μl 1X PBS (calcium, magnesium free) and vortex for 5 sec. 
Centrifuge briefly. 

d) Add 1 μl Calcein AM to the tube containing EthD-1 and vortex. Centrifuge briefly. 

e) Using a wide-bore pipette tip, gently and thoroughly mix cells. 

f) Immediately, aliquot 15 μl cells and mix with 15 μl fluorescent staining solution. Pipette 
gently to mix.   

The volume can be adjusted down to 5 μl of cells and 5 μl of staining solution (1:1 ratio).  

g) Load 25 μl (or less) of the stained cells to a slide (e.g. ibidi µ-Slide VI - Flat). 

h) Wait ~5 – 10 min for Calcein AM to be digested and cells to settle down in the slide. 

i) Image cells using a microscope with a 10X or 20X objective (See Section 4.5). 
  

NOTE 

NOTE 
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4.5. Microscopy & Automated Image Analysis 

This Protocol describes the use of a Nikon Ti-E (Eclipse) inverted microscope with specific objectives and 
fluorescence imaging capabilities. Any equivalent microscope solution can be used as an alternative. 

Microscope Settings 
• Nikon Ti-E (Eclipse) inverted microscope 

• 10X or 20X magnification 

 The majority of a chamber can be imaged with ~5 images under 10X magnification 
(scrolling along the length of the chamber after each image) 

 About half of a chamber can be imaged with ~7 images under 20X magnification 
(scrolling along the length of the chamber after each image) 

• Light source for fluorescence microscopy (mercury vapor lamp or xenon arc lamp) 

• Filter cubes (excitation/emission ranges): 

 Nikon B-2E/C (λ 465-495 / λ 515-555), or equivalent, for live stain 

 Nikon G-2E/C (λ 528-553 / λ 590-650), or equivalent, for dead stain 

Microscope Imaging 

a) Place the ibidi® µ-Slide onto the microscope and focus under bright field illumination. 

b) Switch to the Nikon B-2E/C (λ 465-495 / λ 515-555) filter cube, or equivalent, for the 
live stain and re-focus if necessary. 

c) Save an image of the field of view. 

d) Switch to the Nikon G-2E/C (λ 528-553 / λ 590-650), or equivalent, for the dead stain 
and save an image in the field of view. 

e) Repeat steps b – d until the entire chamber has been imaged. 
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Automated Counting of Live/Dead Cells Images Using Image-J or Fiji 

This sequence of steps allows cells that have been stained with the Live and Dead stains (Section 4.4) to be 
counted automatically, using ImageJ (http://imagej.net) or Fiji (http://fiji.sc). Open each pair of images for a 
given field of view, one in the Live wavelength and the other in the Dead wavelength, and apply the following 
steps to both: 

a) Select Image -> Type -> 8-bit 

b) Select Image -> Adjust -> Threshold 

c) Recommended threshold settings for Dead and Live channel images settings are shown 
below. Depending on the intensity of the fluorescence signal captured in the images, the 
lower threshold may need to be adjusted. Increase the threshold to avoid retaining 
background fluorescence (for high intensity) and decrease the threshold to avoid the 
loss of cells (for low intensity). 
 

  
Dead Live 

 

d) Select Process -> Binary -> Make Binary 

e) Select Process -> Binary -> Open 

f) Select Process -> Binary -> Fill Holes 

g) Select Process -> Binary -> Watershed 

h) Select Analyze -> Analyze Particles 

i) Use the analyze particles settings shown below for the automated counting of cells. 
Record the number of cells counted in each image, found in the Results window. 
 

 
 

j) To determine cell viability %, divide number of live cells by the sum of live and dead 
cells and multiply by 100. 


